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About This Guide

The Getting Started with Pro/INTRALINK 8.0 guide is intended to introduce users 
and administrators of Pro/INTRALINK 3.x to the changes that must be 
understood in order for an effective adoption of Pro/INTRALINK 8.0. 

It is assumed that the reader has access to the complete Pro/INTRALINK 8.0 
documentation set, including the guides listed in the Related Documentation 
section.

Each chapter contains basic information about Pro/INTRALINK 8.0 and includes 
references to additional Windchill documentation for further information. It also 
gives detailed information about anything that is related specifically to 
Pro/INTRALINK 8.0. 

Note:  The Pro/INTRALINK 8.0 and Windchill PDMLink documentation set 
includes information specific to Windchill PDMLink. Rely on this guide to 
indicate the most relevant sections of the Pro/INTRALINK 8.0 and Windchill 
PDMLink documentation.

Related Documentation
The following documentation is directly referenced in this guide and will be 
useful for further information:

• Pro/INTRALINK 8.0 and Windchill PDMLink User’s Guide

• Guide to Using Pro/ENGINEER Wildfire with Windchill

• Windchill Business Administrator’s Guide

• Windchill System Administrator’s Guide

• Windchill Customizer’s Guide

• Windchill Application Developer’s Guide

• Windchill Installation and Configuration Guide

• Windchill Archive Administrator’s Guide

If these books are not installed on your system, see your system administrator.
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Technical Support
Contact PTC Technical Support via the PTC Web site, phone, fax, or e-mail if you 
encounter problems using Windchill-based applications.

For complete details, refer to Contacting Technical Support in the PTC Customer 
Service Guide enclosed with your shipment. This guide can also be found under 
the Support Bulletins section of the PTC Web site at:

http://www.ptc.com/support/index.htm

The PTC Web site also provides a search facility that allows you to locate 
Technical Support technical documentation of particular interest.  To access this 
page, use the following link:

http://www.ptc.com/support/support.htm

You must have a Service Contract Number (SCN) before you can receive 
technical support. If you do not have an SCN, contact PTC License Management 
using the instructions found in your PTC Customer Service Guide under 
Contacting License Management.

Documentation for PTC Products
PTC provides documentation in the following forms:

• Help topics

• PDF books

To view and print PDF books, you must have the Adobe Acrobat Reader installed.

All Windchill documentation is included on the CD for the application. In 
addition, books updated after release (for example, to support a hardware platform 
certification) are available from the Reference Documents section of the PTC 
Web site at the following URL:

http://www.ptc.com/appserver/cs/doc/refdoc.jsp

Comments
PTC welcomes your suggestions and comments on its documentation. You can 
submit your feedback through the online survey form at the following URL:

http://www.ptc.com/go/wc_pubs_feedback

http://www.ptc.com/support/index.htm
http://www.ptc.com/support/support.htm
http://www.ptc.com/appserver/cs/doc/refdoc.jsp
http://www.ptc.com/go/wc_pubs_feedback
http://www.ptc.com/support/support.htm
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Documentation Conventions
Windchill documentation uses the following conventions:

Convention Item Example

Bold Names of elements in the user 
interface such as buttons, menu paths, 
and window titles.

Required elements and keywords or 
characters in syntax formats.

Click OK.

Select File > Save.

License File window

create_<tablename>.sql

Italic Variable and user-defined elements in 
syntax formats.  Angle brackets (< and 
>)  enclose individual elements.

Book titles

create_<tablename>.sql

Monospace Examples

Messages

JavaGen "wt.doc.*" F true

Processing completed.

"Quotation 
marks"

Strings The string "UsrSCM" . . .

The CAUTION symbol indicates 
potentially unsafe situations which 
may result in minor injury, machine 
damage or downtime, or corruption or 
loss of software or data.

When you add a value to an enumerated 
type (for example, by adding a role in the 
RolesRB.java resource file), removing that 
value can result in a serious runtime error. 
Do not remove a role unless you are certain 
there is no reference to it within the 
system.
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About Pro/INTRALINK 8.0
Pro/INTRALINK 8.0 is the latest version of PTC's industry leading 
Pro/ENGINEER Workgroup data management software. This new release 
includes significant enhancements to simplify Pro/ENGINEER data management, 
enhance end-user productivity, improve security, improve integration with PTC's 
Product Development System, and better support global Pro/ENGINEER 
collaboration.

To deliver these improvements, this latest release of Pro/INTRALINK has been 
released on a new Web-based architecture powered by the Windchill 8.0 platform.  
As such, this new release represents a significant change for existing 
Pro/INTRALINK users. Therefore, customers who have deployed previous 
versions of Pro/INTRALINK are encouraged to review this guide and the other 
Pro/INTRALINK 8.0 documentation thoroughly before initiating their installation 
and migration activities. Comprehensive training and deployment services are 
also available to help ensure a successful Pro/INTRALINK 8.0 deployment.

In addition to the benefits mentioned above, the transition to a Web-based 
Windchill architecture has allowed PTC to deliver a common set of 
Pro/ENGINEER data management capabilities for Pro/INTRALINK, Windchill 
PDMLink, Windchill ProjectLink, and Windchill Foundation & PDM. Therefore, 
if a customer should decide to deploy one of these other Windchill-based 
solutions, they can be assured that they will have access to the same powerful 
Pro/ENGINEER data management capabilities that are provided in 
Pro/INTRALINK 8.0 plus the new capabilities provided by these solutions.

Pro/INTRALINK 8.0 Documentation

Pro/INTRALINK 8.0 and Windchill PDMLink share a common set of 
documentation. Throughout this guide, references are made to specific sections 
within those documents. The following is a list of the referenced documentation. 
Each document listed is linked to the PTC Documentation Reference Web site 
where you can choose to view and download the documents. You can also find 
these documents on the Publications page in Pro/INTRALINK 8.0.

• Pro/INTRALINK 8.0 and Windchill PDMLink User’s Guide

• Guide to Using Pro/ENGINEER Wildfire with Windchill

• Windchill Business Administrator’s Guide

• Windchill System Administrator’s Guide

• Windchill Customizer’s Guide

• Windchill Application Developer’s Guide

• Windchill Archive Administrator’s Guide
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The non-administrator Publications page may appear similar to the following 
image:

You can also click the Help button  available from windows and pages in 
Pro/INTRALINK 8.0. Any information specific to Windchill PDMLink is clearly 

marked with  or is noted in the About Pro/INTRALINK 8.0 online help topic 
available from most online help.

Note:  These documents also contain information specific to Windchill 
PDMLink, Windchill ProjectLink, and Windchill Foundation & PDM. 

Pro/INTRALINK 8.0 Terminology

See the Pro/INTRALINK 8.0 Terminology appendix for a comparison of the 
terminology differences between Pro/INTRALINK 3.x and Pro/INTRALINK 8.0. 
See the Glossary for definitions of terminology introduced with Pro/INTRALINK 
8.0.
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Pro/INTRALINK 3.x to 8.0 High-Level Comparison

The following table provides an at-a-glance comparison of the capabilities 
available in Pro/INTRALINK 3.x, Pro/INTRALINK 8.0, and Windchill 
PDMLink. More detailed descriptions of functionality and any differences are 
available in the corresponding sections of this guide.

Capability Pro/INTRALINK 3.x Pro/INTRALINK 8.0
Windchill 
PDMLink

Managing Documents (CAD and Non-CAD)

Store and track versions of 
electronic documents (including 
Pro/ENGINEER CAD files and 
non-CAD files)

X X X

Define templates for different 
document types

X X X

Define and manage user-defined 
attributes for electronic 
document objects

X X X

Rename objects in the database 
apart from the CAD tool

X X X

Define rules to control access to 
objects in the database

X X X

Track and report object history 
(audit trail)

X X X

Use object type to define native 
viewing application

X X X

Select multiple objects and 
modify the value of a common 
attribute

X X X

Create user-defined 
relationships between 
Pro/ENGINEER objects and 
non-Pro/ENGINEER objects

X X X

Define different document types 
and assign a different life cycle 
and set of attributes for each type

X X
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Document history reports 
(rename history, save as history, 
location history)

X X

Support multiple content files 
(for example, primary and 
secondary) for a single database 
object

X X

Manage non-Pro/ENGINEER 
files as secondary content of 
Pro/ENGINEER objects 
(includes control over whether 
or not content is carried foward 
to new versions and iterations)

X X

Support broad product 
information access with a Web 
browser-based user interface for 
enterprise users

X X

Managing Products

Create a baseline, a 
configuration of objects or bill of 
material, at a specific point in 
time for future reference 

X X X

Check out and download 
specific configurations and/or 
versions of a design (for 
example, latest or named 
baseline) for use in a CAD 
application

X X X

Automatically track the as-
stored (or as checked-in) 
configuration of a set of CAD 
objects

X X X

Configure part numbering and 
versioning schemes

X X X

Annotate bills of material 
(product structures) and 2D or 
3D views

X

(Requires Division 
ProductView)

X

(Requires 
ProductView)

X

Capability Pro/INTRALINK 3.x Pro/INTRALINK 8.0
Windchill 
PDMLink
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Completely define a digital 
product structure with associated 
documents created in various 
authoring tools (including CAD 
files, requirements, documents, 
and specification documents)

X

Effectivity-based change control X

Define and manage alternate bill 
of materials

X

Define and manage substitutes 
(alternate parts), part 
occurrences, serialized parts, 
and product instances

X

Create and modify enterprise 
product structure which may or 
may not include heterogeneous 
CAD content 

X

Designate and track serialized 
parts

X

Searching for Information

Flexible searching tools for 
locating objects based on 
attribute values and multiple sets 
of criteria

X X X

Store searches and queries for 
future use

X X X

Search for objects in the 
database without leaving the 
Pro/ENGINEER environment

X X

Search for text in documents 
(full text search) 

X

Life Cycle and Change Management 

Define and track object life 
cycles (release levels)

X X X

End user Set State capabilities X X X

Capability Pro/INTRALINK 3.x Pro/INTRALINK 8.0
Windchill 
PDMLink
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Configure simple routing 
processes for releasing objects 
from one level or life cycle state 
to another

X X X

Viewable access from 
promotion form for non-
Pro/ENGINEER users

X

(Requires 
ProductView)

X

Task notification integrated with 
corporate e-mail

X X

Ad-hoc approval/routing teams X X

Web-based review form for easy 
access

X X

Pre-defined rules for Set State 
and Revise actions

X X

Multiple version schemes X X

Subscription and notification 
tools for automatic e-mail 
notification of object changes

X X

Track and monitor engineering 
change process statistics

X

Out-of-the-box closed-loop 
change process management

X

Define custom workflow-driven 
change process

X

Managing Workflows

Document the configuration, 
policies, and procedures for the 
operation of the system in 
support of ISO 9000 or other 
business process initiatives

X X X

Use a graphical interface to 
create a workflow consisting of 
tasks and roles

X

Capability Pro/INTRALINK 3.x Pro/INTRALINK 8.0
Windchill 
PDMLink
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Create automated tasks and 
assign role-based tasks in a 
workflow. This includes the 
ability to sequentially lay out 
tasks, so one must be completed 
before another begins.

X

Have multiple branches or paths, 
depending on conditions

X

Notify an individual of a new 
task via e-mail or when user logs 
into the system, and the ability to 
send notifications on task events 
(for example, overdue or 
complete)

X

Tools for Collaborative Product Development

Lock objects from being 
changed

X X X

Replace contents of workspace 
and Pro/ENGINEER session 
with new designs from database

X X X

Communicate a designer’s 
intention to modify an object

X

(intent-to-modify 
status)

X

(Lock object)

X

(Lock object)

Easily and securely share data 
with suppliers across firewalls

X X

Automatically warn users when 
changing objects that are not 
checked out, that is, not locked

X X

Design branching (ability to 
pursue design alternatives in a 
temporary environment and later 
merge changes back into the 
main design branch)

X

(Branching)

X

(Revise)

X

(Revise or 
through 
integration with 
Windchill 
ProjectLink

Ability for users to participate in 
discussion forums

X X

Capability Pro/INTRALINK 3.x Pro/INTRALINK 8.0
Windchill 
PDMLink



Getting Started with Pro/INTRALINK 8.0 1-9

Ability to automate the process 
of integrating changes made by 
different users to a common 
Pro/ENGINEER model (parts or 
assemblies)

X

Working with CAD Data

Support all Pro/ENGINEER 
object types and their 
relationships

X X X

Relationship reporting 
capabilities (for example, BOM 
membership, family tables, 
where used, and 
Pro/ENGINEER relationship 
reports)

X X X

Manage Pro/ENGINEER family 
tables as separate objects

X X X

Managed local working 
environment (workspace)

X X X

Update command to keep users 
aware of latest changes made by 
others

X X X

Switch between workspaces X X X

Support bidirectional transfer 
and change of CAD (file-based) 
attributes

Full Capability Full Capability Full Capability

Duplicate (save as) CAD 
product structures

X

(in Workspace)

X

(in database)

X

(in database)

Configure the display of object 
and attribute information (saved 
displays)

X X X

Drag and drop Limited Extensive Extensive

Multiple servers connected to 
one Pro/ENGINEER session

X X

Capability Pro/INTRALINK 3.x Pro/INTRALINK 8.0
Windchill 
PDMLink
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Single integrated user interface X X

Automatically number new 
CAD objects based on a 
company’s part numbering 
system

X X

Out-of-the-box integrations with 
leading third-party CAD 
authoring tools

X

Undo and redo changes made in 
a user’s workspace

X

(Frames and 
Pro/ENGINEER 
Undo/Redo)

Limited

(Pro/ENGINEER 
Undo/Redo)

Limited

(Pro/ENGINEE
R Undo/Redo)

External simplified 
representation report

X

Enterprise System Integration

Seamlessly integrate with other 
legacy business systems with bi-
directional information 
exchange

X X X

Standard (out-of-the-box) 
integrations with leading ERP 
vendors

X

Visualizing Data

Basic lightweight 3D object 
preview from workspace and 
commonspace for 
Pro/ENGINEER users

X

(From 
Pro/INTRALINK 
3.x client window

X

(Through embedded 
browser)

X

(Through 
embedded or 
stand-alone 
browser)

Basic lightweight 3D object 
preview from workspace and 
commonspace for 
Pro/INTRALINK users

X X X

Advanced visualization with 
markup and annotation 
capabilities 

X 

(Requires Division 
ProductView)

X

(Requires 
ProductView)

X

(Requires 
ProductView)

Capability Pro/INTRALINK 3.x Pro/INTRALINK 8.0
Windchill 
PDMLink
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Client-side viewable generation X X

Support for Distributed Product Development (Performance, Scalability, Replication)

Checkout and add to workspace 
as links

X X X

Scalable Web-based, three-tier 
architecture

X X

Performance sensitivity to 
network

High Low Low

Sharing of data between separate 
databases

X

(Package 
replication)

X

(Server-side 
import/export)

X

(Server-side 
import/export)

Distributed content storage 
(vault/content replication) with 
local download

X X X

Replication rules X

(Folders/domains)

X

(Folders/domains, 
object type, object 
state, viewables)

X

(Folders/domai
ns, object type, 
object state, 
viewables)

Replication file size threshold X X

Replication fault tolerance X X

Replication compression X X

Distributed content storage 
(vault/content replication) with 
local upload

X X

Automated content replication X X

Cross-locale support X X

Metadata compression for data 
transfer between client and 
server

X X

Capability Pro/INTRALINK 3.x Pro/INTRALINK 8.0
Windchill 
PDMLink
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Multithreaded downloading and 
uploading, with uploading in 
background

X X

Work offline X X

System Security

Domain-based access control 
(applied to objects in given 
domain, using users, groups, and 
roles)

X X X

Maturity-based access control 
(applied to objects based on 
release level or life cycle state)

X X X

Instance-based access control 
(overrides domain-based access 
control to grant additional 
permissions to individual 
objects)

X X

Audit reporting cababilities 
(such as user activity and project 
activity)

X X

Client-server communication 
protocol

SQL*Net HTTP, HTTPS HTTP, HTTPS

Network zones (firewalls) X

(optional, from 1-3 
firewalls)

X

(optional, from 
1-3 firewalls)

Authenticate users with standard 
Web-based authentication

X X

System Administration and User Interface

Manage users and groups X X X

Backup and recovery X X X

Purging old versions and 
iterations

X X X

An administrator can set default 
user behavior

X X X

Capability Pro/INTRALINK 3.x Pro/INTRALINK 8.0
Windchill 
PDMLink
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Open APIs for customization 
(for example, triggers)

X X X

External LDAP server X X

Customize application user 
interface

X X

Archive and Restore X X

Provide a user-specific home 
page where users can view 
current work, tasks, and 
assignments

X X

Capability Pro/INTRALINK 3.x Pro/INTRALINK 8.0
Windchill 
PDMLink
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Alternative Techniques

The following table lists capabilities available in Pro/INTRALINK 3.x that do not 
directly correspond to capabilities in Pro/INTRALINK 8.0. Where applicable, a 
Pro/INTRALINK 8.0 alternative technique is suggested. 

Pro/INTRALINK 3.x Capability
Pro/INTRALINK 8.0 Alternative 
Technique

Workspace frames Pro/ENGINEER Wildfire 2.0 Undo 
and Redo

Workspace duplicate (with Update 
Partner)

Server-side Save As

Object export from workspace Server-side export or Pro/ENGINEER 
File > Backup

Non file-based attributes File-based attributes (instance-based 
attributes)

Advanced baseline capabilities Create baselines during check in as 
stored configurations

Graphical relationship report References and Referenced By 
relationships

User-defined life cycle attributes May be addressed through 
customization

Folder-based attributes Product and Library attributes

Explicit hold in workspace Download to workspace (without 
checkout) for implicit hold

Integrate Manually merge changes

Shared lock Access control rules and checkout on-
the-fly

Briefcase Clipboard

Branching Revise to create multiple revisions
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Navigating Pro/INTRALINK 8.0

Using the Pro/INTRALINK 8.0 Tabs

When you first open Pro/INTRALINK 8.0, tabs appear at the top of your page. 
These tabs provide access to different information and functionality. The 
following sections describe each tab.

Home Tab
The Home tab contains information specific to your interaction with 
Pro/INTRALINK 8.0. Here, you can view your assignments, items that you have 
checked out, and more. The pages available from the Home tab are described 
below.

Overview
The Overview page displays the seven most recent items in each of the following 
tables:

• Assignments

• Updates

• Checked-Out Work

If a table contains more than seven items, a View All link appears in the bottom-
left corner of the table, allowing you to view all items. You can also click the link 
for a table to view only that table and all of the items contained in it. Links to each 
table are available below the Home tab.
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Assignments
The Assignments page, or task list, displays the tasks that are assigned to you as 
part of a workflow process. A workflow is a series of predefined tasks that 
correspond to a business process in your organization. Depending on your role in 
these business processes, the workflow engine could deliver tasks that ask you to 
review, author, or approve product data. 

For more information about a task that is assigned to you, click the link in the 
Name column of the table, or select Details from the actions list. 

The information page displays the information you need to complete the 
assignment. 

After you complete a task, click Task Complete on this page. The task is then 
removed from your Assignments table, and the workflow process moves forward.

If an item (such as a part or document) is associated with the assignment, a link to 
the information about the item appears in the Subject column of the table. From 
this page, you can view all available information for, and perform actions on, the 
item. 
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If you need to reassign the task or update the deadline, those options are available 
from the Actions column of the table.

Updates
The Updates page lists items that you have recently modified. For example, you 
may check out a document in order to edit the text, and then check in the 
document with your corrections. If the document needs additional editing, you can 
retrieve it from your Updates table rather than have to search for the document or 
locate it in within the folders of the product or library.

Checked-Out Work 
The Checked-Out Work table lists any items that you currently have checked 
out. 

You must check out a part or document in order to modify it. At the time of 
checkout, a working copy duplicates the original object file and becomes the copy 
that you modify. This copy of the item appears in your Checked-Out Work table. 
Checkout locks the original item to prevent change by others. 

Once you are finished modifying an item, you can check in the item from this 
table by clicking Check In in the actions list. Your working copy, with all of its 
attributes and associations, supersedes the present iteration of the item, and the 
item is removed from your Checked-Out Work table.

Workspaces
The Workspaces page displays a listing of workspaces, if any, that you created in 
all products and libraries to which you have access. A workspace provides a 
useful framework that allows you to work with many CAD documents at the same 
time. 

Selecting Workspaces under the Product or Library tab displays a listing of 
only the workspaces associated with the context. 

Once on the Workspaces page, you can create a new workspace, delete an 
existing workspace, or, by clicking the link in the workspace Name column, go to 
an existing workspace.



1-18 Getting Started with Pro/INTRALINK 8.0

Notebook
The Notebook is a collection of links to items and URLs with which you often 
work. Notebooks display these links you have created and allow you to organize 
them in folders and subfolders. Your Notebook is similar to Internet Explorer’s 
Favorites or Netscape Navigator’s Bookmarks. Because the links are saved in the 
Pro/INTRALINK 8.0 database, the links in your Notebook can be accessed from 
anywhere and from any machine. You can also upload documents to your 
Notebook.

See Communication Tools in Windchill PDMLink of the Pro/INTRALINK 8.0 
and Windchill PDMLink User’s Guide for more information about notebooks.

Subscriptions 
A subscription is a request to be notified of certain events concerning documents 
in which you are interested. For example, if you want to know when Document A 
is updated, you subscribe to the document and select the Update event. Then, any 
time the document is updated, an e-mail notification is sent to you. 

From the Subscription page on the Home tab, you can view all of your 
subscriptions and unsubscribe from items. 

Tip:  Subscriptions are not available for all items. If notifications cannot be sent 
for an item, the Subscription link will not appear on the information page.

See Communication Tools in Windchill PDMLink of the Pro/INTRALINK 8.0 
and Windchill PDMLink User’s Guide for more information about subscriptions.

Reports
The Reports page displays a report table that allows you to run the reports across 
products and libraries in which you are a team member.

Note:  Only the items that you created or for which you are the owner are 
displayed on the page.

Click the name of the report you would like to run in the list. For example, you 
may want to see a list of your Overdue Items or your Open Work, relating to 
your Assignments.

Utilities
The Utilities page provides access to items used to change or enhance your 
interaction with Pro/INTRALINK 8.0. For example, links to Setting User 
Preferences, security settings, and software downloads appear on this page. 

Site and Organization
These tabs appear for administrators. For more information, see Chapter 3, 
Administration Information.
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Product Tab
A product can be thought of as all the collected information that defines what is 
built and sold by your company. The product provides the context in which you 
collaborate to create this information, where only those with defined roles have 
access to the information. 

For more information, see the Managing Products and Product Structures chapter 
in the Pro/INTRALINK 8.0 and Windchill PDMLink User’s Guide.

When you click the Product tab, the most recently viewed page of the product 
that you last viewed opens. For example, if the last time you viewed information 
under the Product tab, you viewed the Folders page of Product A, that page 
appears the next time that you click the Product tab. To view information for a 
different product, click the Products List link below the Product tab and select a 
product from the list. You can also select a product from the Recent Products 
drop-down list on the top of the page. 

Once a product has been selected, you can do the following:

• Search for items in the product using the Search within this product field, 
which is located at the top of any page under the Product tab. This returns 
only those items which match your specified criteria and which exist in the 
product from which you are searching. Items contained in other products are 
not returned.

• From the Details page, view the attributes for the product and the end items 
that exist in the product. You can also complete actions from the actions list.

• From the Folders page, view the items that reside in the product and complete 
actions on those items. Use the Current View drop-down list in the table to 
filter the items listed in the table. For example, you can choose to view only 
documents.

• From the Team page, identify the members of the product team who have 
access to the information displayed in this product and the roles to which they 
are assigned.

• From the Forum page, view and discuss topics that relate to the product. 
Team members can reply to existing postings or start new discussions. See 
Communication Tools in Windchill PDMLink of the Pro/INTRALINK 8.0 
and Windchill PDMLink User’s Guide for more information about discussion 
forums.



1-20 Getting Started with Pro/INTRALINK 8.0

• From the Workspaces page, users can view or create personal workspaces 
associated with the product. 

• If you have access, a Templates page and Utilities page may also appear. For 
more information on these pages, see About Administration in 
Pro/INTRALINK 8.0.

Library Tab
A library can be thought of as a place for storing and providing access to business 
information, such as documents and other items that are not related to a single 
product. For example, your company may have a library titled "Design 
Standards."

When you click on the Library tab, the last page of the library that you last 
viewed opens. For example, if the last time you viewed information under the 
Library tab, you viewed the Details page of Library A, that page appears the next 
time that you click the Library tab. To view information for a different library, 
click the Libraries List link below the Library tab and select a library. You can 
also select a library from the Recent Libraries drop-down list on the top of the 
page. 

Once a library has been selected, you can do the following:

• Search for items in the library using the Search within this library field 
located at the top of any page under the Library tab.

• From the Details page, view the attributes that exist for the library. You can 
also complete actions from the actions list.

• From the Folders page, view the items that reside in the library and complete 
actions on those items. Use the Current View drop-down list in the table to 
choose the items listed in the table. For example, you can view only folders.

• From the Team page, view the members of the library who have access to the 
information displayed in this library.

• From the Forum page, view and discuss topics that relate to the library. Team 
members can reply to existing posting or start new discussions. See 
Communication Tools in Windchill PDMLink of the Pro/INTRALINK 8.0 
and Windchill PDMLink User’s Guide for more information about discussion 
forums. 



Getting Started with Pro/INTRALINK 8.0 1-21

• From the Workspaces page, view or create workspaces associated with the 
library. 

• If you have access, a Templates page and a Utilities page may also appear. 
For more information on these pages, see Chapter 3, Administration 
Information.

Using the Header Links

The following links, as well as a Copy Page button and a search field, appear in 
the Windchill header:

Link Description

Visualization 
Collection

Displays the Visualization Collection. The collection 
provides the ability to combine different data sets into one 
viewable representation for the current browser session. 
This portal allows you to view and print visual 
representations of parts and documents in ProductView.

Tip:  The first time you add an object to the collection, this 
link appears.

Learn Displays Windchill tutorials, which walk through 
procedures for completing Windchill operations.

Help Displays online help for the tab you are viewing.

Tip:  To view online help for a particular table, click  
in the upper-right corner of the table. 

Publications Displays the Publications page, which provides links to all 
Windchill manuals. 

E-mail Page Launches a new window that allows you to e-mail the 
current URL to another user.

Hot Links Opens the My Current Hot Links folder of your 
Notebook under the Home tab. Hot links are URLs for the 
Windchill pages you access most frequently. The Add to 

Hot Links button  appears throughout Windchill to 
allow you to save a link to your Hot Links.
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Search
The Search field allows you to locate Product Data Management (PDM) data that 
has been created in Pro/INTRALINK 8.0. Enter keywords in the field, and click 
Go.

To view the Search page, where you can specify search criteria for specific items, 
locations, and fields, click the Search link to the left of the field. 

For more information see the following sections of Searching in Windchill 
PDMLink, of the Pro/INTRALINK 8.0 and Windchill PDMLink User’s Guide:

• About Search

• About the Search Page

• About Search Results

• About Wildcards

Tip:  When used in conjunction with Pro/INTRALINK 8.0, Pro/ENGINEER 
Wildfire users can search for objects in the PDM database without leaving 
Pro/ENGINEER.

Copy Page
The Copy Page button copies the URL of the current page to the Windchill 
clipboard. The URL you have copied can be pasted into any table that accepts 
links or into a text field that has a Paste action associated to it.
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Setting User Preferences
To access the User Preferences page, click Preferences on the Utilities page of 
the Home tab. 

Pro/INTRALINK 8.0 has six categories of user preferences, so you can define 
certain aspects of your functionality. 

• Display

• Content

• Search 

• Tables

• Visualization

• Configuration Specification

Your preferences may differ, depending on the settings at your site.

Tip:  Always click OK or Apply to submit preference information instead of 
pressing ENTER on your keyboard.
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Display Preferences

To customize how certain items of your screen display, click the Display tab. A 
more detailed description of each preference is available when you click on the 
preference link.

Content Preferences

To customize your document upload and download processes, click the Content 
tab. A more detailed description of each preference is available when you click on 
the preference link. 
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Search 
Preferences

To customize your search process, click the Search tab. A more detailed 
description of each preference is available when you click on the preference link.

For information on search modes, see Using Search Modes in Search in Windchill 
PDMLink of the Pro/INTRALINK 8.0 and Windchill PDMLink User’s Guide.
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Table Preferences

To customize how information displays in the tables in Pro/INTRALINK 8.0, 
click the Tables tab. A more detailed description of each preference is available 
when you click on the preference link.
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Setting Visualization Preferences

To customize your visualization options, click the Visualization tab. A detailed 
description of each preference is available when you click the preference link.

If you choose to display thumbnails, small images of the items can be viewed 
from the search results and information pages. 

Thumbnails give you a visual image to associate with the details information of an 
item. You can also launch ProductView by clicking the thumbnail icon; however, 
displaying thumbnails increases the time needed for pages to load.

Note:  You must have ProductView installed in order to customize your 
visualization options.
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Using Special Characters in Pro/INTRALINK 8.0

The following characters have special meaning in HTML and should be avoided 
when entering information in the fields on pages in Pro/INTRALINK 8.0:

• <

• >

• "

• ’

• &

The following actions are not recognized by HTML and should be avoided when 
entering information in the fields in Pro/INTRALINK 8.0:

• Adding more than one space between letters.

• Pressing ENTER.

The following should not be used in UNIX file names:

• \

• The extension ".LNK" or ".lnk."
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Getting Started as an Administrator
The following is a brief comparison of administrative features in 
Pro/INTRALINK 3.x and Pro/INTRALINK 8.0.

Pro/INTRALINK 3.x

• Access control set per release level per folder for a user or a group of users.

• Access controls are specified for all objects within a folder in a particular 
release level.

• All objects in the folder have the same release scheme.

• All objects in the folder have the same access policies.

Pro/INTRALINK 8.0

• Data is organized per product or libraries and then broken down into folders.

• Access control policies are specified per object type for each product and 
library.

• Access control can also be specific to folder within the product and library.

• Life cycle is assigned to a specific object type within a product or library.

• Access control can be specified for an individual object instance in a 
particular life cycle state.

After Pro/INTRALINK 8.0 is installed and configured (as documented in the 
Windchill Installation and Configuration Guide - Windchill), one administrative 
user is set up as well as the Site and organization containers.

Your installed Pro/INTRALINK 8.0 environment consists of a set of containers 
that hold all of the administrative areas (known as domains), rules, and data that 
make up the context from which Pro/INTRALINK 8.0 users work.

The containers are set up in a hierarchy so that the rules and data created in one 
container can be available to child containers and the domains in one container 
can have child domains in a child container. The child domains inherit 
information from ancestor domains.

Pro/INTRALINK 8.0 has an installed top-level Site container and an organization 
container that is created when the base data is loaded. For example, if the 
organization container is named Org1, the following hierarchy applies:

Site

Org1
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In this example, the Org1 organization container inherits rules and data from the 
Site container.

Note:  In Pro/INTRALINK 8.0, there is only one organization container that is 
created by loading the Pro/INTRALINK 8.0 base data, as described in the 
Windchill Installation and Configuration Guide - Windchill.  In Pro/INTRALINK 
8.0, you cannot create additional organization containers. 

Before you can get started with administrative activities in Pro/INTRALINK 8.0, 
you must log on as the Administrator (using the user name defined during the 
Windchill Services installation, for example, wcadmin). This user is a member of 
the Administrators group and has out-of-the box privileges that give you full 
control over all Pro/INTRALINK 8.0 objects. As this user, you can establish an 
organization administrator and select a set of users who are then able to create 
products and libraries.

You can access Pro/INTRALINK 8.0 using a URL from a Web browser.

Note:  The server manager and method server must be running (as well as the 
Web server and servlet engine) before Pro/INTRALINK 8.0 can be accessed. 
Starting services is covered in Administering Pro/INTRALINK 8.0 Services in 
the Administration Information chapter.

The URL string is formatted as follows:

http://<hostname>:<port>/<webapp>

The required parameters were defined when Pro/INTRALINK 8.0 Info*Engine 
was installed. You only need to include the port number when the Web server 
being used is using a port number other than 80 (default). If the Web server is 
using the default port, then you can enter http://<hostname>/<webapp> in your 
Web browser Address (or Location) text box. For example, if you specified ProI8 
for the <webapp> parameter, then the following URL entered in the Web browser 
Address text box will open the Pro/INTRALINK 8.0 home page:

http://<hostname>/ProI8

Tip:  If you are logging on using the same system where Pro/INTRALINK 8.0 is 
installed, you can use localhost as <hostname>.
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The Pro/INTRALINK 8.0 home page that appears is similar to the following:

The tabs at the top of the window identify the major areas provided in 
Pro/INTRALINK 8.0:

• From the Home tab, users manage their daily work, as described earlier in this 
chapter.

• From the Product tab, users have access to all products to which they are a 
member, as described earlier in this chapter. If you are a product creator, you 
can create a product from this tab.

• From the Library tab, users have access to all libraries to which they are a 
member, as described earlier in this chapter. If you are a library creator, you 
can create a library from this tab.

• From the Site tab, site administrators configure and manage the 
Pro/INTRALINK 8.0 system as a whole. This tab is only visible to site 
administrators and is the tab from which the initial administration activities 
are done.
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Tip:  The Organization tab does not appear until you select the organization 
from the page that displays when you select Organizations link on the Site tab.

The organization container that is created when the base data is loaded is created 
using the General (PDM) template. The name of the organization entered during 
the Windchill Services installation becomes the name of the organization 
container and the underlying organization object that is created. Additionally, the 
organization is defined so that the organization can host products and libraries and 
organization members can search for all users, not just those within their 
organization. For information about what is set using the General (PDM) template 
and other organization details, see the Administering Organizations chapter of the 
Windchill Business Administrator’s Guide. 

By default, the administrative user defined during the installation cannot be the 
organization administrator. This is because this user is not defined as a member of 
the organization and the organization administrator must be a member of the 
organization.

Tip:  All members of an organization have the name of the organization set in 
their directory service user entries. This name is set as the value of the 
organization attribute ("o", by default). For example, users with the following 
attribute set are members of the PTC organization:

o=PTC

To establish an organization administrator, click the Administrators link on the 
Organization tab and add one or more users as organization administrators to the 
organization.

Tip:  In a production environment, users are typically defined in an enterprise 
directory that is set up during installation. If you are setting up a test system and 
do not have a set of users from which to select administrators, you can create a set 
of test users in the default directory service using the Principal Administrator. The 
Principal Administrator is available from the Site tab. Click the Utilities link and 
then click the Principal Administrator link to open the Principal Administrator.

At a minimum, you need to either update the Administrator user so the user is a 
member of the organization or create another user who can be the organization 
administrator. This user can then administer the organization and create products 
and libraries. Additionally, you can add other users as product and library 
creators. Product and library creators are maintained through the Creators link on 
the Organization tab. From the Organization tab, click the Creators link and 
then choose the type of creator from the Current View drop-down list on the 
Creators table.

After the administrators are established, you can log on as those users and manage 
your organization or create products and libraries.

For additional information on site, organization, product, and library containers, 
see the following chapters in the Windchill Business Administrator’s Guide:
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• Administration Overview - for general information

• Administering Containers - for major container concepts

• Administering Organizations - for details on using the Organization tab

• Administering the Site - for details using on the Site tab

• Administering Products and Libraries - for details on administering 
Pro/INTRALINK 8.0 products and libraries

The following sections provide some information about products used with 
Pro/INTRALINK 8.0.

Using Oracle

Like Pro/INTRALINK 3.x, Pro/INTRALINK 8.0 leverages an Oracle database.  
In order to support different customer needs, PTC offers two versions of 
Pro/INTRALINK: one that includes a bundled Oracle database, and one that does 
not. Customers who have purchased the bundled version of Pro/INTRALINK 
receive their Oracle software from PTC. Customers who purchased the version of 
Pro/INTRALINK that does not include Oracle must obtain the Oracle software on 
their own. Customers who purchased the version of Pro/INTRALINK that 
includes Oracle are provided with an Oracle Software Assistant which will guide 
you through the installation of the required Oracle software. In either case, see the 
Windchill Installation and Configuration Guide - Windchill for installation 
details. 

For help with managing your Oracle database, see Managing the Database with 
Oracle Tools section in the Administration Information chapter.

Using Visualization Services

If you have purchased ProductView, you can install Visualization Services for 
your Windchill-based application. These services include ProductView Lite, the 
thumbnail generator,the thumbnail viewer, and the collaboration agent from 
within Pro/INTRALINK 8.0. For information about Visualization Services, see 
the Windchill Installation and Configuration Guide - Visualization Services.
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2
Understanding New Concepts

This chapter explains new concepts introduced in Pro/INTRALINK 8.0, including 
management of documents and CAD documents and working with CAD data.
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Working with CAD Data.....................................................................................2-6
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Managing Context Teams .................................................................................2-10
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Tools for Collaborative Product Development

Communication Tools

Many companies face the challenge of working effectively together when 
working across multiple sites and with other companies. People usually work in 
several different ways to develop product concepts, update ideas for the team, and 
communicate these ideas; however, often issues arise when an update is made, but 
not clearly communicated. Pro/INTRALINK 8.0 provides functionality that 
overcomes these challenges. For example, you can use Pro/INTRALINK 8.0 in 
the following ways to communicate clearly with your team:

• Create new iterations of a document and send an e-mail to the team

• Discuss design ideas using a discussion forum

• Keep track of the work you need from other team members by subscribing to 
changes

• Comment on designs using the markup capabilities in ProductView

For more information, see the following sections of Communication Tools in 
Windchill PDMLink, Pro/INTRALINK 8.0 and Pro/INTRALINK 8.0 and 
Windchill PDMLink User’s Guide:

• Subscriptions

• Discussion Forums

Collaborating in Pro/INTRALINK 8.0

Modifying an Object
In Pro/INTRALINK 3.x, you can lock an object using the Lock action. In 
Pro/INTRALINK 8.0, locking an object is an automatic part of the check-out 
operation.

In Pro/INTRALINK 3.x, you can also set the status of an object to Lock or Intent 
to Modify. This protects the object from modification by another user. In 
Pro/INTRALINK 8.0, you can protect the object by checking it out, which keeps a 
modified version of the object from being checked in by any other user.

In Pro/INTRALINK 3.x, you can use the Integrate functionality to merge changes 
made by different users to a common Pro/ENGINEER model. However, in 
Pro/INTRALINK 8.0, the formerly mentioned capabilities efficiently prevent 
different users from making changes to a common object at the same time.

Update workspace and Pro/ENGINEER session contents
In Pro/INTRALINK 8.0, you can update the workspace and Pro/ENGINEER 
session so that your view includes the latest modifications others have made to 
objects you are using. This is accomplished by using the download, update, and 
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other actions. For more information, see the Keeping Workspace Items Up-to-
Date section of the Basic PDM Operations chapter of the Guide to Using 
Pro/ENGINEER Wildfire With Windchill.

Share peer-to-peer visualization sessions
This capability is part of ProductView and the Windchill Visualization Service, 
which is part of Windchill PDMLink. In Pro/INTRALINK 8.0, customers can add 
this capability by adding the Division Graphics Server and Division ProductView.

Design Branching 
Design branching is the ability to pursue design alternatives in a temporary 
environment and later merge changes back into the main design branch.

Pro/INTRALINK 3.x supports this capability with specific branching 
functionality. Pro/INTRALINK 8.0 does not have a formal notion of branching. 
However, Pro/INTRALINK 8.0 provides users with more flexible revisioning that 
can be used to support some types of design branching. Unlike Pro/INTRALINK 
3.x, when you create a new version in Pro/INTRALINK 8.0, the original version 
is not locked. For example, after revising an object from A.4 to B.1, a user may 
continue to work on version A while other users work on version B, given the 
proper access controls.  This is not possible with Pro/INTRALINK 3.x. Another 
way to support design branching is through the use of Windchill ProjectLink and 
Windchill PDMLink.

Managing Documents

Understanding Document Management

The document management functions allow you to create, view, modify, and 
manage documents.

A document is a database object that can be used to store and manage non-CAD 
files, such as Microsoft Word and Microsoft Excel documents. 

Within Pro/INTRALINK 8.0, documents reside in the folders of a specific 
product or library. You can perform document actions from the Folders page in 
the product or library or from the pages available from the Home tab. A list of 
actions is available from the Actions column, or icons may be available in the 
toolbar of the table.To view the attributes of a document and perform actions on 
the document, select Details and the document information page appears.

The online help available on the information pages gives complete descriptions of 
the attributes, links, and tables shown as well as the actions that can be performed. 
Additionally, your site may have created custom attributes that appear with the 
details. 

For more information about document management, see the following sections of 
the Chapter 4, Managing Documents, of the Pro/INTRALINK 8.0 and Windchill 
PDMLink User’s Guide:
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• Creating Documents

• Viewing Documents

• Associating Files and Documents

• Modifying Documents

• Options for Downloading Documents

Managing Documents in Pro/INTRALINK 8.0

Store and track versions of documents 
In Pro/INTRALINK 3.x unique objects are assigned a revision and version (N.n).  
The default revision sequence is 1,2,3,..n. This sequence can be customized. The 
version sequence is always 1,2,3,..n.  An object's revision is changed using the Set 
Revision action. Pro/INTRALINK 3.x automatically increments the version of an 
object each time the object is checked in. 

In Pro/INTRALINK 8.0, unique objects are assigned a version and iteration 
(M.m). The default version sequence is A,B,C,... This sequence can be 
customized. The iteration sequence is always 1,2,3,..n. An object's version is 
changed using the Revise action. Pro/INTRALINK 8.0 automatically increments 
the iteration of an object each time the object is checked in.

Manage and track standard and user-defined attributes
Both Pro/INTRALINK 8.0 and Pro/INTRALINK 3.x support standard system-
defined attributes. These systems also provide the ability to specify user-defined 
attributes. Pro/INTRALINK 8.0 provides flexibility for defining attribute types. . 
However, Pro/INTRALINK 8.0 does not support the following attribute types:

• Non-file based attributes

• Folder-based attributes

• Life cycle attributes

Define rules to control access to objects
Pro/INTRALINK 3.x access controls are defined for users and/or groups on 
folders and release levels.  Access controls apply a particular role for a particular 
user or group at a particular release level. 

Pro/INTRALINK 8.0 access controls are based on domain, object type, location 
(including folder), team, life cycle state, and role.

For more information, see Administering Access Control in Chapter 3, 
Administration Information.
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Track and report object history (Audit Trail)
Both Pro/INTRALINK 3.x and Pro/INTRALINK 8.0 provide full version and 
iteration history capabilities. Pro/INTRALINK 3.x also provides an audit trail 
report that includes other object changes, such as renames, deletions, and 
promotions. Pro/INTRALINK 8.0 provides administrators with the ability to 
configure additional auditing capabilities.

Provide product information access with a Web browser
Pro/INTRALINK 3.x uses a Java client that requires separate installation on each 
desktop.

Pro/INTRALINK 8.0 leverages an intuitive Web browser-based user interface and 
Web surfing style navigation that is ideal for broad enterprise access and can be 
used through the integrated Pro/ENGINEER Wildfire browser or a standalone 
HTML browser.

Associate documents
Pro/INTRALINK 3.x provides user-defined relationships that allow users to 
manually associate one object to another.

Pro/INTRALINK 8.0 supports the concept of secondary content. This allows 
users to store multiple content files with a single CAD document. The native CAD 
file is called primary content. Any additional content, such as specification 
documents or IGES files are attached as secondary content.

Managing CAD Structures
The database of Pro/INTRALINK 8.0 is structured such that all information 
uniquely defining a product is collected in one logical location. A person with 
administrative privileges, creates this common location called a product. One of 
the implications of creating products is the capability to specify which users will 
be able to access and/or modify product information. For example, if you create a 
CAD document within the location of a product (which is also referred to as the 
product context) only users who have access privileges to that product can view or 
modify the document.

Pro/INTRALINK 8.0 assumes each product will have at least one top-level 
assembly that represents a unit of product functionality that is sold, assembled, 
and delivered to the customer. The complete details of the structure of this top-
level assembly can be obtained from the CAD document structure (Model 
Structure Report).

Create and modify CAD product structures
Pro/INTRALINK 3.x CAD structure modification tools are designed to work with 
Pro/ENGINEER CAD objects. These tools provide the ability to duplicate 
existing Pro/ENGINEER structures and to create new Pro/ENGINEER structures, 
including unplaced memberships for Pro/ENGINEER assemblies that are not 
geometrically constrained.
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Pro/INTRALINK 8.0 includes the ability to duplicate Pro/ENGINEER CAD 
structures using a Save As action that is executed on the Pro/INTRALINK 8.0 
server.

Check-out and download specific configurations for use in a CAD application
Pro/INTRALINK 3.x provides custom check-out configurations, as stored 
configurations, and named baselines.  

Pro/INTRALINK 8.0 provides configuration specification capabilities, as stored 
configurations, and named baselines.

Configure part numbering and versioning schemes
Both Pro/INTRALINK 3.x and Pro/INTRALINK 8.0 systems provide the ability 
to configure versioning schemes. Pro/INTRALINK 8.0 also allows customers to 
tailor these schemes based on the object’s life cycle maturity. Additionally, 
Pro/INTRALINK 8.0 provides the ability to configure automatic part numbering.

Working with CAD Data

About CAD Documents

A document is a database object containing files in application format. CAD 
documents are Windchill objects that are used to store and manage CAD 
information files (the output of CAD authoring applications).

A CAD document typically has content and attributes that are relevant to the 
external application only, such as Pro/ENGINEER files (3D models, drawings, 
viewable images, analyses, and so on). It can contain both primary content (for 
example, a 3D CAD model file) and secondary content (for example, an IGES 
file).

For more information about CAD documents, see the CAD Document section of 
the Introduction to Using Windchill with Pro/ENGINEER chapter of the Guide to 
Using Pro/ENGINEER Wildfire with Windchill.

About the Workspace

The workspace is a private area where you can manage multiple objects and 
perform basic PDM operations. In addition to managing a users locally modified 
data, the workspace is also designed to facilitate concurrent engineering. The 
workspace tracks which objects have been modified locally, as well as by other 
users, and provides tools to enable a user to update their Pro/ENGINEER session 
with the latest data from the commonspace. In Pro/INTRALINK 3.x, the 
Workspace completely resides on the client machine. In Pro/INTRALINK 8.0, 
there are two components to the workspace: the workspace cache and the 
serverside workspace. The workspace cache resides on the local client machine, 
and the serverside workspace resides in the user’s personal cabinet on the server. 
This enhanced workspace architecture allows users to more easily access work-in-
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progress data from different workstations and allows system administrators to 
back-up work-in-progress data that has not been checked into the database. As in 
Pro/INTRALINK 3.x, the workspace maintains knowledge of what CAD files and 
objects are on your local machine and what you have downloaded in use in a CAD 
application.

For more information about workspaces, please see the Workspaces and the 
Commonspace section in the Introduction to Using Windchill with 
Pro/ENGINEER chapter of the Guide to Using Pro/ENGINEER Wildfire with 
Windchill.

Working with CAD Data in Pro/INTRALINK 8.0

Relationship Reporting 
Pro/INTRALINK 3.x provides a comprehensive set of reporting tools that can 
report on Pro/ENGINEER objects and relationships, such as model structure, 
family tables, where-used, and Pro/ENGINEER relationships. 

Like Pro/INTRALINK 3.x, Pro/INTRALINK 8.0 continues to offer reports for 
model relationships (used by and uses), family tables, and model structures. In 
addition to these reports, Pro/INTRALINK 8.0 introduces new reports for rename 
history, save as history, and location history. Furthermore, expanded capabilities 
are provided for difference reporting and creating custom reports.

Automatically number new CAD objects based on a company’s part numbering system
Pro/INTRALINK 8.0 provides out-of-the-box autonumbering capabilities. This 
provides the ability to automatically assign a new part number to new CAD 
objects and enterprise objects in the database.

For more administrator information, see the Managing CAD Document and 
WTPart Naming and Numbering chapter of the Customizing and Administrating 
Pro/ENGINEER Wildfire guide.

Visualizing Data in Pro/INTRALINK 8.0

About Visualization

Both Pro/INTRALINK 3.x and Pro/INTRALINK 8.0 include built-in 
Pro/ENGINEER previewing capabilities. With Pro/INTRALINK 3.x, these 
capabilities are accessible from the Pro/INTRALINK workspace and 
commonspace browser. With Pro/INTRALINK 8.0, dynamic previewing of 
Pro/ENGINEER models is provided in the Pro/ENGINEER Wildfire 2.0 
embedded browser.

Optional advanced visualization capabilities can be added through the use of 
ProductView and include the following: 

• Rich viewing and markup of models, drawings, and images
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• Optional legacy documents and PDF viewing and markup

• Pro/ENGINEER Wildfire 2.0 annotation feature support

• Real-time collaboration between multiple ProductView users

• Advanced 3D model interrogation from accurate, yet compact, geometry

• Optional Realizer module provides interference checking, animation creation, 
and interactive mechanisms

• Optional Composer module provides interactive creation and editing of 
assembly sequences

Customers upgrading from Pro/INTRALINK 3.x and the Division Graphics 
server to Pro/INTRALINK 8.0 will see the following improvements:

• 3D thumbnail viewing

• Server-enforced watermarking

• Automatic viewable replication

• Client-side viewable creation

• Improved accuracy for metadata synchronization

• Publishing priority control

• Improved system architecture

• Single database

• Improved scalability

• More robust infrastructure

• Improved administration tools

• More efficient publishing of large assemblies

Pro/INTRALINK 8.0 provides the following capabilities out of the box:

• 3D object preview from information pages in the Pro/ENGINEER Wildfire 
embedded browser

• Preview from Pro/ENGINEER using the File > Open menu selection

These basic capabilities are essentially the same as those provided with 
Pro/INTRALINK 3.x.

For more information about ProductView Lite Edition, see the following sections 
of Chapter 9, Visualizing Data in Windchill, of the Pro/INTRALINK 8.0 and 
Windchill PDMLink User’s Guide:

• Accessing Visualization

• ProductView Features
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• Publishing Visualization Data

• Setting Preferences

If ProductView Standard Edition has been purchased, additional documentation is 
provided upon installation of the tool.

Managing Life Cycles 
Like Pro/INTRALINK 3.x, Pro/INTRALINK 8.0 includes life cycle management 
tools (known as Release Levels and Release Procedures in Pro/INTRALINK 3.x) 
to define and advance the maturity of a design. Moreover, Pro/INTRALINK 8.0 
adds configuration rules that provide greater flexibility and control over how 
design content progresses and is managed throughout all phases of the product 
development life cycle. At each phase of the life cycle, different access control 
rules and different versioning schemes can be enforced to provide precise control 
over who has access to the data and how revisions are tracked.

These capabilities provide many important benefits, including:

End-user benefits
• Task notification integrated with corporate e-mail

• Flexible additions to approval groups

• Web-based form for easy access

• Viewable access from promotion request for non-Pro/ENGINEER users (with 
ProductView option)

Administrative benefits
• More flexible life cycle (release scheme) definition

• More flexible promotion criteria

• Predefined rules for Set State behavior

• Predefined rules for Revise behavior

• Multiple version number schemes

Pro/INTRALINK 8.0 provides a variety of business processes that can be used to 
mature different types of product development deliverables. For detailed 
information, see the Managing the Life Cycle of Items chapter of the 
Pro/INTRALINK 8.0 and Windchill PDMLink User’s Guide.

• Revise Documents -- Enables you to create a new version of the item. 
Transition rules can be set up to control the life cycle state of the new version 
based on the state of the version being revised. 

• Set State -- Enables you to informally set the life cycle state of an item. 
Depending on the transition rules, this action may or may not be available.
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• Promotion Request -- Enables you to set the state of one or more items to a 
new life cycle state as part of a review process. Depending on the transition 
rules, this action may or may not be available.

For more information on creating life cycles or setting life cycle transition rules, 
see the About Administration in Pro/INTRALINK 8.0 later in this guide.

Managing Context Teams
A context team is a list of the members of a product or library context. All 
members of the context can view the context team.

Team members are assigned roles within the context. A context manager role is 
automatically assigned to the creator of the context; however, the creator can 
assign the role to other team members. The context manager roles available are as 
follows:

• Product context -- Product Manager

• Library context -- Library Manager

If you are the context manager or the administrator of the organization where the 
context resides, you can modify the team from the Team page by adding and 
removing roles, users, and groups. You can define a team using any of the roles 
that are predefined for your organization or for your context, or you can define 
new roles that are specific to a context. Then you can add members to one or more 
roles in the team. Users may have different roles in each context in which they are 
participants. In one context, a user can be the context manager while in another 
context, the user can be a member.

For more information about roles and groups, see the online help available from 
the Team page. 

The team table information can be displayed differently using the available views 
from the Current View drop-down list.

• Members -- Displays the users and groups invited as team members to 
participate in a team.

• Members By Role -- Displays the team information organized by role with 
assigned team members listed under the roles. You can expand and collapse 
the different roles to view certain information and hide other details.

• All People -- Displays the users in the team with the groups expanded to 
reveal the names of any group participants. If no groups are a part of the team, 
this view displays the same information as the Members view.

For more information, see the Managing Teams chapter of the Pro/INTRALINK 
8.0 and Windchill PDMLink User’s Guide and the Windchill Business 
Administrator’s Guide.
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3
Administration Information

This chapter provides information for administrators of Pro/INTRALINK 8.0, 
including configuring your environment and using administrative utilities.
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About Administration in Pro/INTRALINK 8.0
Most of the information regarding administration of Pro/INTRALINK 8.0 is 
contained in the Windchill Business Administrator’s Guide. For more information 
about improved security and enhanced reporting, see the Windchill System 
Administrator’s Guide. However, these guides are written for administrators of all 
Windchill solutions and contain information regarding Windchill Foundation & 
PDM, Windchill ProjectLink, and Windchill PDMLink. Only the general 
information and the information specific to Windchill PDMLink is relevant to 
Pro/INTRALINK 8.0.

Understanding Administration in Pro/INTRALINK 8.0

The following sections give you some general information about the 
administration capabilities in Pro/INTRALINK 8.0.

• Ability to seamlessly integrate with other legacy business systems with 
bidirectional information exchange - Customers can integrate Windchill 
PDMLink with other non-standard systems using Windchill Info*Engine 
adapters. Customers can integrate Pro/INTRALINK 8.0 with other enterprise 
systems using the Pro/INTRALINK Toolkit.

• Scalable Web-based, three-tier architecture - Pro/INTRALINK  8.0 uses a  
modern Web-based, three-tier  architecture software built using Web 
technology, Web-delivered Java and HTML end-user interface, middle-tier 
server logic and workspace logic, and Oracle database and external file 
storage back-end server components.

• Ability to distribute storage (vault/content replication) securely with 
guaranteed delivery - Pro/INTRALINK 3.x, Pro/INTRALINK 8.0, and 
Windchill PDMLink support distributed storage. Pro/INTRALINK 3.x, 
however, does not support guaranteed delivery; furthermore, 
Pro/INTRALINK 3.x replication does not support HTTP or HTTPS. This is 
only available to Pro/INTRALINK 8.0 and Windchill PDMLink multi-site 
customers.

• Support check-in to distributed storage (local check-in) - Pro/INTRALINK 
8.0 content replication includes a Content Cache Server that supports check-in 
of content files to replicated file vaults. This provides significant performance 
benefits for users on a wide area network. This is only available to 
Pro/INTRALINK 8.0 multisite customers.

• Automated sharing of data between separate databases - The multisite version 
of Pro/INTRALINK 3.x provides Package Replication capabilities that can be 
used to partially automate the sharing of library data between different 
Pro/INTRALINK Commonspaces. Similarly, the multi-site version of 
Pro/INTRALINK 8.0 and Windchill 8.0 supports import and export 
capabilities that can be used to share library data between separate 
Pro/INTRALINK 8.0 or Windchill 8.0 databases.
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• Efficiently manage users and groups - Pro/INTRALINK 3.x does not support 
LDAP; however, Pro/INTRALINK 8.0 and Windchill PDMLink do support 
LDAP.

You can create and manage users in the Aphelion LDAP directory bundled 
with Pro/INTRALINK 8.0 or you can configure Pro/INTRALINK 8.0 to use 
an enterprise directory service that you maintain outside of Pro/INTRALINK 
8.0. Aphelion is installed and configured as part of the process of installing 
Pro/INTRALINK 8.0. For the details on how to manually configure an 
existing enterprise directory service, see the Windchill Installation and 
Configuration Guide.

Pro/INTRALINK 8.0 uses the Aphelion directory to store group information 
for all of the groups you can create in Pro/INTRALINK 8.0.

• Ability to deploy the system in a highly secure, redundant configuration - 
Pro/INTRALINK 8.0 can be configured with one or more firewalls and a 
reverse proxy. Furthermore, Pro/INTRALINK 8.0 supports single sign-on and 
provides the ability to encrypt database content.

• Ability to transport data in an encrypted format - Pro/INTRALINK 8.0 
provides the ability to: 

– Comply with US and international encryption laws and standards

– Activate SSL with the HTTPS protocol to encrypt sensitive Web traffic

– Use 128 bit encryption keys with SSL encryption

– Store passwords in an encrypted format

• Ability to withstand outside attacks - Pro/INTRALINK 8.0 can be configured 
to prevent:

– Client side scripting

– SQL insertion attacks

– Buffer overflow

– Packet sniffing

Pro/INTRALINK 8.0 can also be integrated with intrusion detection software.

Archiving and Purging in Pro/INTRALINK 8.0

In the 8.0 release, Pro/INTRALINK allows a search for archives if Windchill 
Archive is installed. This search can be made by archive name or it may be based 
on archived objects. The installation of Windchill Archive explained in the 
Windchill Archive Administrator’s Guide is valid for Pro/INTRALINK 8.0.

Pro/INTRALINK 3.x has flexible purging tools that can be used to remove 
unwanted versions and iterations of database objects. Pro/INTRALINK 8.0 also 
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provides purging capabilities and the ability to authenticate users with standard 
Web-based authentication, SecurID, Verisign, and digital certificates.

Managing the Database with Oracle Tools
Certain database administration functions require the direct use of Oracle tools. 
The following table lists some key functions, and provides for each function a 
reference to the Oracle documentation that covers it. For your convenience, copies 
of the referenced Oracle documentation are available online at:

http://www.ptc.com/appserver/cs/doc/refdoc.jsp

Database Administration 
Function Oracle Documentation

Database startup Oracle 9i Database Administrator’s Guide, 
Chapter 4, Starting Up and Shutting Down

Database shutdown Oracle 9i Database Administrator’s Guide, 
Chapter 4, Starting Up and Shutting Down

Database export Oracle 9i Database Utilities, Chapter 1, Export

Database import Oracle 9i Database Utilities, Chapter 2, Import

Database backup/restore Use the export/import utilities

Changing database 
parameters

Oracle 9i Database Administrator’s Guide, 
Chapter 2, Creating an Oracle Database

Resizing datafiles Oracle 9i Database Administrator’s Guide, 
Chapter 12, Managing Datafiles

http://www.ptc.com/appserver/cs/doc/refdoc.jsp
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Configuring Your Pro/INTRALINK 8.0 Environment
As described in the Getting Started with Pro/INTRALINK 8.0 chapter, your 
Pro/INTRALINK 8.0 system consists of the Site and organization containers, and 
any number of product and library containers. The Site and organization 
containers are created during the installation process; users who have the correct 
set of privileges can create product and library containers.

After containers are created and users become team members, the framework 
established is called the context from which the users work. In many instances, the 
context includes the contents of a specific container and the domains, rules, and 
data available from ancestor containers. For example, if a user entering 
Pro/INTRALINK 8.0 navigates to a folder within the Bike Design product and 
creates a new document, that document is managed in the context of the Bike 
Design product. Persons with access to the Bike Design product may 
automatically have the right to see and modify the new document.

Each context provides the following:

• The context structure, which includes the default domains and folders.

• Context participation for Pro/INTRALINK 8.0, which includes the available 
roles, teams, and groups.

• Default access policies.

• Data types and object initialization rules.

• Default life cycle, workflow, context, team, and report templates.

The base data that is loaded during the installation process creates the out-of-the-
box templates for containers, workflows, life cycles, teams, and reports, and 
associates them with the System domain that is in the Site container. These 
templates are then available to descendent containers where appropriate. 

To provide a consistent Pro/INTRALINK 8.0 environment, PTC recommends that 
you keep most of the basic system structure and rules the same across all 
containers. To do this, the basic structure and rules need to be set in the Site 
container and then not changed by lower-level containers. For details on what is 
set for the Site container and for more information about containers, see the 
following chapters in the Windchill Business Administrator’s Guide:

• Administration Overview

• Administering Containers

• Administering the Site

When you create a product or library, you must select a template (which is then 
used to create the product or library container). The product and library templates 
set additional folders (in some cases) and provide additional roles and 
corresponding access policies for the roles. Using templates for these purposes 
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makes it easy to have a different set of roles and corresponding access policies for 
the roles in each product and library.

Additionally, the product and library templates can set object initialization rules 
for specific data types that establish the following:

• Numbering and versioning scheme to be used for parts, documents, and CAD 
documents

• Default life cycle, workflow, and team templates for parts, documents, and 
CAD documents

Setting these items in a product or library template allows you a lot of flexibility; 
but, depending on your situation, it could produce unwanted results. PTC 
recommends that you determine the numbering and versioning scheme you want 
to use for all products and libraries, and establish which life cycle, workflow, and 
team templates you want to use. Then set these in the Site container rather than in 
a product or library template.

PTC provides a set of product and library templates that you can use while testing 
your Pro/INTRALINK 8.0 system. For the details on what is set in each template, 
see the Administering Products and Libraries chapter in the Windchill Business 
Administrator’s Guide. 

For most Pro/INTRALINK 8.0 environments, PTC recommends that you test 
using the Product Design template. Besides setting up a common set of roles used 
in the product design process, it establishes default life cycle templates that follow 
the one phase and two phase development cycles. Additionally, the Product 
Design template sets the versioning scheme to the out-of-the-box, state-based 
versioning scheme. This scheme works with the Life Cycle Administrator 
Version Series drop-down list and is used in the One Phase Development and 
Two Phase Development out-of-the-box life cycle templates.

After completing your testing, determine the numbering and versioning schemes, 
and the default life cycle, workflow, and team templates you want to use on your 
system and set those items in the Site container (if they are not the defaults already 
set there) using the Object Initialization Rules administrator from the Site 
Utilities page. For information about using the Object Initialization Rules 
administrator, see the Administering Containers chapter in the Windchill Business 
Administrator’s Guide.

Tip:  To always use a rule set in the Site container (and, therefore, not use rules 
set in product or library containers), you can specify the following AttrValue 
attribute on the XML rule set in the Site container:

final="true"

For example, the following XML code sets the default folder to "Default" for 
documents and allows no child container to modify this default:

<AttributeValues objType="wt.doc.WTDocument">
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  <AttrValue id="folder.id" 
algorithm="com.ptc.core.foundation.folder.server.impl.FolderPathAttributeAlgorithm" 
final="true">

    <Arg>/Default</Arg>

  </AttrValue>

</AttributeValues>

For additional information about specifying the XML code used as object 
initialization rules, see the Object Initialization rules help.
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Defining Document Types and Adding User-Defined 
Attributes to Objects

The Type Manager allows you to create new subtypes of documents and CAD 
documents (both of which are modeled types) and types you have created with the 
Type Manager (soft types). In addition, you can add new attributes to and set 
constraints on the newly created soft types. For conceptual information about 
types and the runtime typing capability, see the chapter on Using Types and the 
Type Manager in the Windchill Business Administrator’s Guide.

You can access the Type Manager from the Utilities pages that are under the Site 
and Organization tabs. The Type Manager link from the Site tab provides you 
(as the system administrator) with unrestricted access to all types. The link from 
the Organization tab provides access to only those types that are in the 
organization context that is active when you launch the Type Manager.

Administering the Numbering of Documents and CAD 
Documents

Numbering schemes control how numbers are generated for documents and CAD 
documents. Each object class has its own numbering scheme.

A rules load file sets the initial numbering rules for documents and CAD 
documents. The loaded numbering schemes for parts, documents, and CAD 
documents are simple Oracle sequences that have been loaded into the Windchill 
database. Each starts at 1 and increments by 1.

You can view and update the rules that are being used from the Object   
Initialization Rules table using the Object Initialization Rules Administrator. For 
details on assessing the Object Initialization Rules Administrator, see the 
Windchill Business Administrator's Guide.

Administering Teams and Roles
You can establish product and library teams (known as context teams) by clicking 
the Team link from the Product or Library tab to access the Team table. From 
this table, you can administer a product or library team.

Tip:  Instead of adding individual users to the roles that are established in a team, 
you can define groups of users and then add the groups to the roles. Often groups 
can be established at the organization level using the Groups link from the 
Organization tab. Then these groups can be added as members under specific 
roles in the team. Using this method provides easier maintenance when updating 
teams when there are personnel changes in your organization. For additional 
information, see Administering Teams in the Administering Product and Libraries 
chapter of the Windchill Business Administrator’s Guide.

Teams and team templates are used throughout Pro/INTRALINK 8.0. For more 
information, see the chapter Administering Teams and Roles in the Windchill 
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Business Administrator’s Guide. Although you can add participants to a team 
directly though the team template, consider managing the participants through the 
context teams you establish from the Teams link available on the Product and 
Library tabs. 

Team and team templates make it possible to define a smaller number of life 
cycles, since the life cycle roles can be mapped to team roles, rather than to 
specific users and groups. For more information about life cycles, see the chapter 
Administering Life Cycles in the Windchill Business Administrator’s Guide.

Administering Access Control
As a Pro/INTRALINK 8.0 administrator, you must ensure that only the 
appropriate principals have access to objects. These decisions are expressed as 
access control rules governing domains. Defining these rules determines the types 
of iterations principals can have with objects of a specific object type and a 
specific life cycle state.

For example, you can create a rule that gives the Publication group permission to 
modify objects of type CAD Document when they are in the Under Review state 
of their life cycle. Together, such rules form an access control policy for the 
domain. Subsequently, access control lists (ACLs) are derived from the policy for 
a domain and the policies of all its ancestor domains to enforce your access 
decisions.

Access control rules are heirarchical.The default set of access control rules is set 
in the Site container and these rules can be superseded or additional rules set 
through the organization container and then also through the product or library 
container. At the product and library level, the rules set are determined by the 
template that you select when you create the product or library. For the details on 
what is set in the default rules established through the site, organization and 
product or library, see the out-of-the-box rules sections in the Windchill Business 
Administrator’s Guide.

When users are viewing the attributes of an object where some of the attributes 
reference access controlled objects, such as principals, then whether the user sees 
the value of the attributes is determined by whether the user has Read permission 
for the referenced objects. Typically, when a user does not have Read permission 
for a referenced object, the field shows (Secured Information) instead of the 
attribute value. For example, assume that a user displays information about a 
product. If the user displaying the product information does not have Read 
permission for the user who created the product, then the name of the user will not 
appear. Instead of the name, the user sees (Secured Information).

For more information, including strategies for developing useful roles, see the 
Administering Access Control chapter of the Windchill Business Administrator’s 
Guide.
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Administering Workflows and Life Cycles

Workflow Processes

Pro/INTRALINK 8.0 does not include the ability to create or modify workflows. 
You do have some out-of-the-box workflows available. 

Life Cycle

You can access the Life Cycle Administrator by clicking the Life Cycle 
Administrator link on the Utilities pages that are under the Site, Organization, 
Product, and Library tabs. The Life Cycle Administrator link from the Site tab 
provides you (as the site administrator) with unrestricted access to all life cycles. 
The link from the Organization tab provides access to only those types that are in 
the organization context that is active when you launch the Life Cycle 
Administrator. The link from the Product and Library tabs provides access to 
only those types that are in the context that is active when you launch the Life 
Cycle Administrator.

From the Product and Library tabs, the Life Cycle Administrator shows all life 
cycle templates from that contex, the organization context, and the site context. 
From the Organization tab, you see life cycle templates from the organization 
context and the site context. From the Site tab, you see only site-level life cycle 
templates.

For more information, see the chapter Administering Life Cycles in the Windchill 
Business Administrator’s Guide.

Life Cycle/Release Schemes Comparison

Capabilities Pro/INTRALINK 3.x Pro/INTRALINK 8.0

Administrative

Definition By folder only More options (item type, 
subtypes, product or 
library)

Promotion criteria By folder and release 
level

More options (state, 
item type, subtypes, 
product or library, and 
multiple process 
options)

Set state behavior Manual Predefined rules

Revise behavior Manual Predefined rules

Version number scheme One Multiple options (item 
type and life cycle state)
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End User

Set state Yes Yes

Promotion Process Yes Yes

Configuration options Yes Yes

Automatic viewable No With Visualization 
option

Task notification Only in 
Pro/INTRALINK

Integrated with 
corporate e-mail

Approval teams Fixed Approval groups Flexibe additions to 
Approval groups

Review form Only in 
Pro/INTRALINK

Easy to use/ Web-based

Traceable baseline Yes Yes

Full text searchable No Yes

Capabilities Pro/INTRALINK 3.x Pro/INTRALINK 8.0
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Using Life Cycles for Promotion Requests

Pro/INTRALINK 8.0 and Windchill PDMLink provide two out-of-the-box 
promotion life cycles for promoting items, such as documents and CAD 
documents: One Phase Development and Two Phase Development. PTC 
recommends using the One Phase Development life cycle for CAD documents in 
Pro/INTRALINK 8.0. The Two Phase Development life cycle should be used 
only for Windchill PDMLink.
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Administering Pro/INTRALINK 8.0 Services
To run Pro/INTRALINK 8.0, you must have the following third-party products 
running:

• A Web server -- if you are using Apache as your Web server, see the Starting 
and Stopping Apache section in the Windchill Info*Engine Installation and 
Configuration Guide for details.

• A servlet engine -- if you are using Tomcat as your servlet engine, see the 
Starting and Stopping Tomcat section in the Windchill Info*Engine 
Installation and Configuration Guide for details.

• The Aphelion directory -- see the Starting and Stopping the Aphelion 
Directory chapter in the Windchill Info*Engine Installation and 
Configuration Guide for details.

You can start and stop the Pro/INTRALINK 8.0 sever manager and method server 
by using one of the following:

• On Windows, use a Windows shortcut.

If the shortcuts were created when Info*Engine and Windchill Services were 
installed, you can use a shortcut to start the Windchill method server and the 
windchill shell.

Shortcuts can be created in the Windows Start menu, on the desktop, and in 
the Quick Launch Bar. For additional details, see the Windchill Installation 
and Configuration Guide - Windchill.

• To start the servers, enter the windchill start command from a windchill shell; 
to stop the method servers, enter windchill stop. 

For example, to start the servers, enter the following from a command line 
prompt:

windchill shell

The windchill shell brings up a new command shell, from the parent shell that 
is setup for the Windchill environment. This includes setting all environment 
variables needed for Pro/INTRALINK 8.0. In the new window, enter:

windchill start

• When you are logged on as the Administrator, you can use the System 
Configurator to start and stop method servers. 

When the server manager is running, you can access the System Configurator 
from the Site Utilities page. 

When your server manager is down, you can access the System Configurator 
Server Status page by entering the following URL in your Web browser:

http://<host>/<webApp>wtcore/jsp/wt/sysadm/SystemConfigurator.jsp



3-14 Getting Started with Pro/INTRALINK 8.0

where <host> is the host system (and port, if you are not using the default 
port of 80) where Windchill is installed and <webApp> is the Web 
application name defined for Windchill (the default is Windchill).

From the Server Status page, you can then start or stop the server manager, 
start or stop individual method servers, and check the status of all servers.

For additional information about using the Windchill commands or the System 
Configurator, see the Windchill System Administrator’s Guide.
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Customizing Pro/INTRALINK 8.0
Pro/INTRALINK 8.0 provides comparable capabilities to the Pro/INTRALINK 
3.x platform in all respects, including customization; however, additional licenses 
may be required for some customization cababilities.

With Pro/INTRALINK 8.0 and in support of specific business processes, 
customers can create many types of applications including:

• Creating server side triggers and event handlers by implementing Windchill 
services and listeners

• Integrating to an external change management application via appropriate 
Windchill Info*Engine adapters 

• Integrating to a ERP/MRP system via appropriate Windchill Info*Engine 
adapters (excluding the Windchill ESI Module)

• Creating new user interfaces by extending or configuring the 
Pro/INTRALINK 8.0 user interface

• Creating composite applications that combine data from Pro/INTRALINK 8.0 
and other applications

While the entire Windchill data model and APIs are included in the 
Pro/INTRALINK 8.0 package, customizations that expose features of Windchill 
PDMLink not already in Pro/INTRALINK 8.0 are not allowed or supported.  
These include applications that leverage the following Windchill business objects 
and capabilities:

• Parts, products, product instances, and part views

• Change Management

• Integration to ERP or other enterprise systems through the Windchill ESI 
module

• Workflow engine and workflow applications

• Extensions to the Pro/INTRALINK 8.0 data model. That is, it will not be 
permissible to add tables to the Pro/INTRALINK 8.0 Oracle Schema.

The reason for not allowing such customizations is that PTC believes that it will 
be significantly more economical for customers to acquire these capabilities from 
PTC than build them themselves. For such applications, customers are encouraged 
to upgrade to Windchill PDMLink and get the following benefits:

• Complete integration across all application areas

• Upgradeability, maintainability, and supportability

• Lower total cost of ownership

The following documentation is available
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• Windchill Customizer’s Guide

• Windchill Application Developer Guide

• Windchill API documentation

• List of Pro/INTRALINK 8.0 supported packages

• Subset of Rose Model available in HTML format

• Documentation for how to create Services and Processors without the use of 
Rational Rose

• Windchill UML Model Documentation

While Pro/INTRALINK 3.x Toolkit applications and triggers are coded in C 
programming language which has to be compiled and distributed for each 
hardware target platform, Pro/INTRALINK 8.0 is fully based on the JAVA 
programming language which is platform independent.

Due to the architecture of Pro/INTRALINK 3.x most toolkit customizations are 
implemented as client side triggers. Pretriggers often check the validity of a check 
in or promote request. Post triggers often initiate the creation of deliverables like 
plot files or even exchange data with external systems. With Pro/INTRALINK 8.0 
the architecture differs in that most of such customizations will be implemented 
directly on the server by the means of event listeners which can veto the client 
action when required. This server-oriented architecture is much more stable and 
scalable compared to the old client-oriented Pro/INTRALINK 3.x architecture 
which is more often affected by network outages or users terminating the 
Pro/INTRALINK 3.x client while the trigger is still executing.

Another aspect of the new Pro/INTRALINK 8.0 architecture is that all 
Pro/ENGINEER CAD file operations, such as Download to Workspace, Upload 
to the Commonspace, and the dependency management are now handled 
internally by the Pro/ENGINEER Wildfire session. Therefore all 
Pro/INTRALINK 3.x toolkit functions for the management of workspace and 
library items are no longer available within the Pro/INTRALINK 8.0 API. 

Pro/INTRALINK 8.0 API

The following table lists the specific chapters and sections of the Pro/TOOLKIT 
manual relevant to the Pro/INTRALINK 8.0 API and the corresponding JAVA 
packages. It is provided in order to allow the experienced Java programmer to 
navigate more quickly through the Windchill Java API. It is mandatory to have a 
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full understanding of the Windchill architecture and customizations concepts 
before creating CAD document centric customizations.  

Pro/Toolkit Manual Chapter Corresponding Packages

Chapter 4, Session Management 
Functions

Log in

Transactions

wt.auth

wt.pom

Chapter 5, Error Handling

Function Error Status

wt.util

Chapter 6, Object Relationship 
Functions

Dependency Graph

Baseline

Dependency

wt.graph

wt.vc.baseline

wt.epm.structure

Info*Engine Webjects

Chapter 7, User Functions

User and Group

Role

Action

wt.org

wt.team

action validators

Chapter 8, Authorization Functions

PDM Authorization

Object and Domain-based 
Authorization

Attribute Authorization

wt.session

wt.access

wt.team

Chapter 9, Data Organization 
Functions

File Space

File Vault

Folder

wt.inf.container

wt.fv

wt.folder 
com.ptc.core.foundation.folder. 
com.ptc.netmarkets.folder

Chapter 10, File Replication

Defining Preferred Content Cache Site

wt.fv.

wt.prefs

Chapter 11, Query Functions wt.query.*

Info*Engine Webjects
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Chapter 12, PIV Specifier Language

Configuration

wt.vc.config

Chapter 13, Conflicts com.ptc.windchill.cadx.console

Chapter 14, Triggers

Trigger Functions

Creating a Trigger

wt.services

Chapter 17, Checkout Functions

Fetching Product Item Versions

Checkout

wt.vc.config

wt.vc

Chapter 19, Baseline and Branch wt.vc.baseline

wt.vc

Chapter 20, Concurrent Design 
Functions

wt.vc.wt.vc.wip

wt.lock

Chapter 21, Product Item Functions

Product Item

Product Item Type Definition

Product Item Version

Release Scheme

Revision Scheme

wt.epm.

wt.lifecycle

via configuration and wt.series

Chapter 22, Library Navigation wt.epm.structure

Chapter 23, Attribute Functions

Attributes

Attribute Class

Attribute Definition

Chapter 25, Promote 

Promote/Demote Privileges

wt.auth

wt.lifecycle

Chapter 26, Object History

Get History Functions

wt.lifecycle

Pro/Toolkit Manual Chapter Corresponding Packages
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The following table lists the Windchill 8.0 packages that are supported in 
Pro/INTRALINK 8.0:

Chapter 27, Purge

Chapter 28, Release Management wt.lifecycle

Pro/Toolkit Manual Chapter Corresponding Packages

Windchill 8.0 Packages Available for 
Pro/INTRALINK 8.0

com.infoengine.object

com.infoengine.util

com.ptc.core.adapter.server.impl

com.ptc.core.ca.co.client.action

com.ptc.core.ca.co.client.address

com.ptc.core.ca.co.client.cache

com.ptc.core.ca.co.client.component

com.ptc.core.ca.co.client.doer

com.ptc.core.ca.co.client.doer.function

com.ptc.core.ca.co.client.element

com.ptc.core.ca.co.client.environment

com.ptc.core.ca.co.client.event

com.ptc.core.ca.co.client.frame

com.ptc.core.ca.co.client.layout

com.ptc.core.ca.co.client.list

com.ptc.core.ca.co.client.menu

com.ptc.core.ca.co.client.misc

com.ptc.core.ca.co.client.picker
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com.ptc.core.ca.co.client.plugin

com.ptc.core.ca.co.client.primitive

com.ptc.core.ca.co.client.property

com.ptc.core.ca.co.client.property.binary

com.ptc.core.ca.co.client.property.date

com.ptc.core.ca.co.client.property.enumerated

com.ptc.core.ca.co.client.property.hyperlink

com.ptc.core.ca.co.client.property.integer

com.ptc.core.ca.co.client.property.real

com.ptc.core.ca.co.client.property.string

com.ptc.core.ca.co.client.propertyPanel

com.ptc.core.ca.co.client.search

com.ptc.core.ca.co.client.selection

com.ptc.core.ca.co.client.simple

com.ptc.core.ca.co.client.table

com.ptc.core.ca.co.client.table.pref

com.ptc.core.ca.co.client.tree

com.ptc.core.ca.co.client.windchill

com.ptc.core.ca.co.client.wizard

com.ptc.core.ca.co.common.config

com.ptc.core.ca.generic.config.common

com.ptc.core.ca.generic.config.descriptor.comm
on.impl

com.ptc.core.ca.generic.config.utilities.common
.ipml

com.ptc.core.ca.generic.statuspanel.common

Windchill 8.0 Packages Available for 
Pro/INTRALINK 8.0
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com.ptc.core.ca.swing.datatransfer.client

com.ptc.core.ca.web.client.action

com.ptc.core.ca.web.client.address

com.ptc.core.ca.web.client.cache

com.ptc.core.ca.web.client.content

com.ptc.core.ca.web.client.doer.function.impl

com.ptc.core.ca.web.client.element

com.ptc.core.ca.web.client.environment

com.ptc.core.ca.web.client.frame

com.ptc.core.ca.web.client.gw

com.ptc.core.ca.web.client.layout

com.ptc.core.ca.web.client.list

com.ptc.core.ca.web.client.menu

com.ptc.core.ca.web.client.misc

com.ptc.core.ca.web.client.picker

com.ptc.core.ca.web.client.plugin

com.ptc.core.ca.web.client.primitive

com.ptc.core.ca.web.client.property

com.ptc.core.ca.web.client.property.binary

com.ptc.core.ca.web.client.property.date

com.ptc.core.ca.web.client.property.enumerated

com.ptc.core.ca.web.client.property.hyperlink

com.ptc.core.ca.web.client.property.integer

com.ptc.core.ca.web.client.property.real

com.ptc.core.ca.web.client.property.string

Windchill 8.0 Packages Available for 
Pro/INTRALINK 8.0
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com.ptc.core.ca.web.client.propertyPanel

com.ptc.core.ca.web.client.search

com.ptc.core.ca.web.client.selection

com.ptc.core.ca.web.client.table

com.ptc.core.ca.web.client.tree

com.ptc.core.ca.web.client.wizard

com.ptc.core.client.doer.function.impl

com.ptc.core.client.picker

com.ptc.core.client.property.binary

com.ptc.core.client.table

com.ptc.core.client.web.action

com.ptc.core.command.common

com.ptc.core.command.common.bean.entity

com.ptc.core.command.common.bean.repositor
y

com.ptc.core.command.common.delegate

com.ptc.core.foundation.admin.server.processor
s

com.ptc.core.foundation.client.co.action

com.ptc.core.foundation.client.doer.function.im
pl

com.ptc.core.foundation.client.web.action

com.ptc.core.foundation.content.client

com.ptc.core.foundation.content.server.impl

com.ptc.core.foundation.fc.server.impl

com.ptc.core.foundation.folder.common

com.ptc.core.foundation.folder.server.impl

Windchill 8.0 Packages Available for 
Pro/INTRALINK 8.0
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com.ptc.core.foundation.generic.common

com.ptc.core.foundation.generic.server.impl

com.ptc.core.foundation.instance.server

com.ptc.core.foundation.lifecycle.server.impl

com.ptc.core.foundation.locks.common

com.ptc.core.foundation.occurrence.server.impl

com.ptc.core.foundation.org.server.impl

com.ptc.core.foundation.persistable.server.impl

com.ptc.core.foundation.queue.client.web.prope
rty.string

com.ptc.core.foundation.session.server.impl

com.ptc.core.foundation.team.server.impl

com.ptc.core.foundation.util.common

com.ptc.core.foundation.vc.common

com.ptc.core.foundation.vc.views.server.impl

com.ptc.core.foundation.vc.wip.common

com.ptc.core.foundation.wvs.server.impl

com.ptc.core.HTMLtemplateutil.server.process
ors

com.ptc.core.logic.repository.common.impl

com.ptc.core.meta.common

com.ptc.core.meta.common.impl

com.ptc.core.meta.container.common

com.ptc.core.meta.container.common.impl

com.ptc.core.meta.descriptor.common

com.ptc.core.meta.descriptor.server.impl

Windchill 8.0 Packages Available for 
Pro/INTRALINK 8.0
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com.ptc.core.meta.type.command.typemodel.co
mmon

com.ptc.core.meta.type.command.typemodel.se
rver

com.ptc.core.meta.type.common.

com.ptc.core.meta.type.common.impl

com.ptc.core.meta.type.mgmt.common

com.ptc.core.meta.type.runtime.common

com.ptc.core.meta.type.runtime.server.impl

com.ptc.core.meta.type.runtime.server.impl

com.ptc.core.meta.type.runtime.server.impl.mo
deled

com.ptc.core.meta.type.sever

com.ptc.core.query.command.common

com.ptc.core.query.common.impl

com.ptc.core.query.report.bom.common

com.ptc.core.query.report.bom.server

com.ptc.core.query.report.client.generation

com.ptc.core.query.report.command.common

com.ptc.core.util.feedback.common

com.ptc.core.util.feedback.common.impl

com.ptc.netmarkets.folder

com.ptc.netmarkets.forumTopic

com.ptc.netmarkets.projmgmt

com.ptc.netmarkets.subscription

com.ptc.netmarkets.util.misc

com.ptc.windchill.cadx.caddoc

Windchill 8.0 Packages Available for 
Pro/INTRALINK 8.0
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com.ptc.windchill.cadx.cancelcheckout

com.ptc.windchill.cadx.checkin

com.ptc.windchill.cadx.checkout

com.ptc.windchill.cadx.common

com.ptc.windchill.cadx.common.container

com.ptc.windchill.cadx.common.pageBuilder

com.ptc.windchill.cadx.common.pageBuilder.d
esc

com.ptc.windchill.cadx.common.picker

com.ptc.windchill.cadx.common.picker.table

com.ptc.windchill.cadx.common.util

com.ptc.windchill.cadx.console

com.ptc.windchill.cadx.delete

com.ptc.windchill.cadx.deletews

com.ptc.windchill.cadx.editattachments

com.ptc.windchill.cadx.move

com.ptc.windchill.cadx.multirevise

com.ptc.windchill.cadx.newcaddoc

com.ptc.windchill.cadx.newcaddoctemplate

com.ptc.windchill.cadx.newfolder

com.ptc.windchill.cadx.prowt.download

com.ptc.windchill.cadx.prowt.openinproe

com.ptc.windchill.cadx.remove

com.ptc.windchill.cadx.rename

com.ptc.windchill.cadx.revise

com.ptc.windchill.cadx.search

Windchill 8.0 Packages Available for 
Pro/INTRALINK 8.0
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com.ptc.windchill.cadx.update

com.ptc.windchill.cadx.upload

com.ptc.windchill.cadx.ws

com.ptc.windchill.cadx.wsoption

com.ptc.windchill.enterprise.change2.server.im
pl

com.ptc.windchill.enterprise.copy.server

com.ptc.windchill.enterprise.doc.server

com.ptc.windchill.enterprise.org.client.impl

com.ptc.windchill.enterprise.part.server.impl

com.ptc.windchill.enterprise.patternForPicker.c
lient

com.ptc.windchill.enterprise.prefs.server.proces
sors

com.ptc.windchill.enterprise.search.client

com.ptc.windchill.enterprise.templates

com.ptc.windchill.enterprise.templates.doc.serv
er

com.ptc.windchill.pdmlink.clients.beans

com.ptc.windchill.pdmlink.clients.beans.explor
er

com.ptc.windchill.pdmlink.clients.folderexplore
r

com.ptc.windchill.pdmlink.clients.prodmgmt

com.ptc.windchill.pdmlink.clients.util

com.ptc.windchill.pdmlink.clients.vc

com.ptc.windchill.pdmlink.doc.client

com.ptc.windchill.pdmlink.doc.client

Windchill 8.0 Packages Available for 
Pro/INTRALINK 8.0
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com.ptc.windchill.pdmlink.doc.server

com.ptc.windchill.pdmlink.doc.server.processor
s

com.ptc.windchill.pdmlink.lifecycle.server.proc
essors

com.ptc.windchill.pdmlink.load

com.ptc.windchill.pdmlink.search

com.ptc.windchill.pdmlink.search.server.proces
sors

com.ptc.windchill.pdmlink.subscription.server.
processors

com.ptc.windchill.pdmlink.templates.doc.server

com.ptc.windchill.pdmlink.templateutil.server.p
rocessors

wt.access

wt.adapter

wt.admin

wt.audit

wt.auth

wt.boot

wt.build

wt.cache

wt.change2

wt.change2.htmlclient

wt.change2.process

wt.clients.beans

wt.clients.beans.explorer

wt.clients.checker

Windchill 8.0 Packages Available for 
Pro/INTRALINK 8.0
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wt.clients.content

wt.clients.dnd

wt.clients.dndMicroApplet

wt.clients.doc

wt.clients.folder

wt.clients.folderexplorer

wt.clients.gui

wt.clients.homepage

wt.clients.prefs

wt.clients.util

wt.clients.util.http

wt.clients.vc

wt.clients.widget

wt.content

wt.doc

wt.enterprise

wt.enterprise.tabularresults

wt.epm

wt.epm.build

wt.epm.clients.relateditems

wt.epm.familytable

wt.epm.identity

wt.epm.listeners

wt.epm.ndi

wt.epm.structure

Windchill 8.0 Packages Available for 
Pro/INTRALINK 8.0
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wt.epm.structure.occurrences

wt.epm.supportingdata

wt.epm.upload

wt.epm.util

wt.epm.workspaces

wt.events

wt.fc.batch

wt.fc.collections

wt.fc.delete

wt.fc.manifest

wt.federation

wt.feedback

wt.folder

wt.folder.cache

wt.fv

wt.fv.master

wt.graph

wt.graph.processor

wt.graph.service

wt.help

wt.htmlutil

wt.httpgw

wt.httpgw.filter

wt.iba.definition

wt.iba.definition.service

Windchill 8.0 Packages Available for 
Pro/INTRALINK 8.0
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wt.iba.value.litevalue

wt.identity

wt.index

wt.inf.container

wt.inf.library

wt.inf.team

wt.inf.template

wt.intersvrcom

wt.introspection

wt.ixb.actor

wt.ixb.clientAccess

wt.ixb.conflictFramework

wt.ixb.conflictFramework.conflictResolution

wt.ixb.handlers.forclasses

wt.ixb.handlers.netmarkets

wt.ixb.mapping

wt.ixb.objectset

wt.ixb.objectset.handlers.navigator

wt.ixb.publicforapps

wt.ixb.publicforhandlers

wt.lifecycle

wt.load

wt.locks

wt.mail

wt.manager

Windchill 8.0 Packages Available for 
Pro/INTRALINK 8.0
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wt.maturity

wt.meeting

wt.meeting.actionitem

wt.meta

wt.method

wt.notify

wt.occurrence

wt.org

wt.org.electronicIdentity

wt.org.electronicIdentity.engines

wt.pdmlink

wt.pds

wt.pom

wt.prefs

wt.prefs.delegates

wt.prefs.registry

wt.query

wt.query.report

wt.query.template

wt.queue

wt.recent

wt.replication.export

wt.replication.imp

wt.replication.receiver

wt.replication.sender

Windchill 8.0 Packages Available for 
Pro/INTRALINK 8.0
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wt.replication.unit

wt.rule

wt.rule.impl

wt.rule.init

wt.rule.util

wt.security

wt.series

wt.services

wt.services.applicationcontext.implementation

wt.session

wt.sysadm

wt.taglib.util

wt.team

wt.templateutil.components

wt.templateutil.navigationbar

wt.templateutil.processor

wt.templateutil.table

wt.tools.profiler

wt.ufid.delegates

wt.units

wt.util

wt.util.resource

wt.util.version

wt.util.xml

wt.util.xml.xpath

Windchill 8.0 Packages Available for 
Pro/INTRALINK 8.0
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wt.util.xml.xslt

wt.vc

wt.vc.baseline

wt.vc.config

wt.vc.sessioniteration

wt.vc.struct

wt.vc.views

wt.vc.wip

wt.viewmarkup

wt.visitor

Windchill PDMLink 8.0 Packages Available 
for Pro/INTRALINK 8.0

com.ptc.windchill.pdmlink.clients.beans

com.ptc.windchill.pdmlink.clients.folderexplore
r

com.ptc.windchill.pdmlink.clients.util

com.ptc.windchill.pdmlink.clients.vc

com.ptc.windchill.pdmlink.doc.server.processor
s

com.ptc.windchill.pdmlink.load

com.ptc.windchill.pdmlink.search

com.ptc.windchill.pdmlink.search.server.proces
sors

com.ptc.windchill.pdmlink.subscription.server.
processors

com.ptc.windchill.pdmlink.templates.doc.server

com.ptc.windchill.pdmlink.templateutil.server.p
rocessors

Windchill 8.0 Packages Available for 
Pro/INTRALINK 8.0
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A
Pro/INTRALINK 8.0

Terminology

Pro/INTRALINK 3.x and Pro/INTRALINK 8.0 Terminology
The following table lists and describes terminology differences between 
Pro/INTRALINK 3.x and Pro/INTRALINK 8.0. See the Glossary for definitions 
of terminology introduced with Pro/INTRALINK 8.0.

Pro/INTRALINK 3.x 
Term

Pro/INTRALINK 3.x 
Term Definition

Pro/INTRALINK 8.0 
Term

Pro/INTRALINK 8.0 
Term Definition

Revision Unique 
Pro/INTRALINK 
objects are assigned a 
revision and version 
(N.n, where N is the 
revision). The default 
revision sequence is 
1,2,3, and so on. An 
object's revision is 
changed using the Set 
Revision action.

Version Unique Windchill 
objects are assigned a 
revision and an 
iteration, which 
together comprise a 
version (N.n, where N is 
the revision). The 
default revision 
sequence is A, B, C, and 
so on. An object's 
revision is changed 
using the Revise action.

Version The default version 
sequence is 1,2,3, and 
so on. The version of an 
object increments each 
time the object is 
checked in.

Iteration The default iteration 
sequence is 1,2,3, and so 
on. The iteration of an 
object increments each 
time the object is 
checked in.
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Set Revision Action to change a 
Pro/INTRALINK 3.x 
object's revision level.

Revise Action to change a 
Pro/INTRALINK 8.0 or 
Windchill PDMLink 
object's version.

Check out Transfers object 
metadata and content to 
a workspace on the local 
client machine.

Download Transfers object 
metadata and content to 
a workspace on the local 
client machine.

Lock Assigns modify access 
for an object to a single 
user, preventing other 
users from creating new 
versions/iterations of 
the object in the 
database.

Check out Assigns modify access 
for an object to a single 
user, preventing other 
users from creating new 
versions/iterations of 
the object in the 
database.

Check in A command that allows 
users to update the 
database with new 
versions/iterations of 
objects based on the 
changes made in to 
objects in a workspace.

Check in Allows users to update 
the database with new 
versions/iterations of 
objects based on the 
changes made to objects 
in a workspace.

Hold A manual operation 
applied to one or more 
objects to explicitly 
prevent a user from 
unintentionally 
checking in any changes 
made to the object.

Download without 
check out

Modifies a downloaded 
object without checking 
it out. Similar to Hold in 
Pro/INTRALINK 3.x.

Object History 
Report

The object history 
report records the 
details about an object’s 
history, including 
creation, new versions, 
check in forms, and 
renames.

Iteration History
Version History
Saved As History

The Windchill iteration, 
version, and save as 
history reports provide 
details about an object’s 
history, including 
version history, iteration 
history, and save as 
history.

Pro/INTRALINK 3.x 
Term

Pro/INTRALINK 3.x 
Term Definition

Pro/INTRALINK 8.0 
Term

Pro/INTRALINK 8.0 
Term Definition
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Briefcase A briefcase is a 
temporary collection of 
objects added from 
different places so that 
you can modify them as 
separate entities from a 
single location. Actions 
available within the 
briefcase include multi-
object Checkout, 
Delete, Promote, and 
Add to Baseline.

Notebook A notebook is a 
collection of links 
created and organized 
into folders and 
subfolders. A link is a  
URL to something 
either inside or outside 
of the Windchill system. 
You cannot perform 
actions on the objects 
themselves from the 
notebook.

Release scheme A release scheme is 
sequential set of release 
levels. Release levels 
are used to track an 
object's life cycle. 
Release levels are 
grouped into release 
schemes to reflect 
different life cycles for 
different objects. A 
release scheme is 
assigned to a folder and 
is used for all objects in 
the folder.

Life cycle A life cycle is a 
sequential set of phases 
and gates. Each phase is 
referred to as a life cycle 
state. A life cycle is used 
to manage business 
objects as they progress 
from conceptualization 
through obsolescence. 
Each object can be 
assigned a different life 
cycle regardless of its 
storage location. Life 
cycle assignment can be 
controlled by Object 
Initialization Rules.

Release level The development of an 
object for release 
follows a general 
progression of increased 
maturity. Release levels 
represent the different 
states of maturity that a 
model passes through 
from start to finish. 

Life cycle state Life cycles define the 
states and transitions 
associated with the 
maturity of various 
business objects.

Pro/INTRALINK 3.x 
Term

Pro/INTRALINK 3.x 
Term Definition

Pro/INTRALINK 8.0 
Term

Pro/INTRALINK 8.0 
Term Definition
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RTP (Request to 
Promote) Process or 
Promotion Process

A promotion process is 
used to advance the 
release level of 
engineering artifacts. 
Any version can be 
promoted or demoted.

Promotion Request or 
Promotion Process

A promotion request is 
used to advance the 
business maturity level 
of engineering artifacts. 
The promotion review 
process can be used to 
author, review, and 
release versions of items 
based on their life cycle 
states. Only the latest 
iteration of a version can 
be promoted or 
demoted.

Release Form, RTP 
Form, Release Level 
Change Form, 
Promotion Form

Release forms (RTP 
Forms) create a 
persistent record of the 
set of items promoted 
by a given promotion 
request.

Promotion Request Promotion requests 
create a persistent 
record of the set of items 
promoted by a given 
promotion request.

Work in Progress 
(WIP)

A specific release level 
commonly used by 
Pro/INTRALINK users. 
For example, a design 
engineering release 
scheme may have the 
following release levels: 
Work In Progress, 
Checking, and 
Released.

In Work A specific life cycle 
state commonly used by 
Windchill users.

PI (Product Item)

PIV (Product Item 
Version)

The product item is the 
master object in 
Pro/INTRALINK.  A 
product item version is a 
specific version of that 
object that holds the 
content.

CAD Document master

CAD Document 
iteration

The CAD document 
master is the master 
object. A CAD 
document iteration 
contains a specific 
iteration of that object 
that holds the actual 
CAD data content.

Pro/INTRALINK 3.x 
Term

Pro/INTRALINK 3.x 
Term Definition

Pro/INTRALINK 8.0 
Term

Pro/INTRALINK 8.0 
Term Definition
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PIV Info Page The information page 
for an item. It is 
accessed using the 
Object > Information 
or RMB > Information 
menu selections.

information pages Item information pages 
are available in 
Pro/INTRALINK 8.0 
but are not specifically 
labeled as such. To view 
an item’s information 
page, click the Details 
button  next to the 
item or select Details 
from the item’s actions 
list.

Baseline A collection of specific 
PIVs.

Managed Baseline A collection of specific 
CAD document 
iterations.

File Based Attribute An attribute that is 
shared by both 
Pro/ENGINEER and 
Pro/INTRALINK 
which can only be 
edited in a 
Pro/ENGINEER 
session or in the 
workspace. Changes to 
file-based attributes 
require a check-out and 
check-in transaction to 
be updated.

Instanced Based 
Attribute

An attribute that is 
shared by both 
Pro/ENGINEER and 
Pro/INTRALINK which 
can be edited in a 
Pro/ENGINEER session 
or in Pro/INTRALINK 
8.0. Changes to file-
based attributes require 
a check-out and check-
in transaction to be 
updated.

Dependency 
Attribute

An attribute on a link 
between two different 
objects.

Dependency Attribute An attribute on a link 
between two different 
objects.

Storage Cluster The logical storage 
location.

File Vault The logical storage 
location.

Vault The physical storage 
location.

File Folder The physical storage 
location which is 
mounted to a file vault.

File Replication Allows files to be 
replicated to a different 
storage cluster.

Content Replication Allows files to be 
replicated from and to a 
replicata vault managed 
by a separate replica 
site.

Pro/INTRALINK 3.x 
Term

Pro/INTRALINK 3.x 
Term Definition

Pro/INTRALINK 8.0 
Term

Pro/INTRALINK 8.0 
Term Definition
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File Server Basic service for storing 
files into vaults.

Replica Site Lightweight Windchill 
installation for storing 
files into replica vaults.

Pro/INTRALINK 3.x 
Term

Pro/INTRALINK 3.x 
Term Definition

Pro/INTRALINK 8.0 
Term

Pro/INTRALINK 8.0 
Term Definition
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Glossary

This glossary defines terminology that is introduced in Pro/INTRALINK 8.0.

Container
Containers are set up in a hierarchy so that the rules and data created in one 
container can be available to child containers and the domains in one 
container can have child domains in a child container. The child domains 
inherit information from ancestor domains.

Domain
A collection of objects that are subject to the same administrative policies, 
such as access control, indexing, event notification, and external file vaulting.

Library
A library provides a place for storing and providing access to business 
information, such as documents and parts.

Life cycle
In Windchill applications, an automated, graphical model, that employs 
phases and gates to manage business objects as they progress from 
conceptualization through obsolescence.

Part
In Windchill PDMLink, a part typically represents an entry in the PDM/ERP-
BOM. A part can be linked to a CAD document which holds the CAD data. 
Parts are not available in Pro/INTRALINK 8.0, but references to parts may 
appear in Windchill documentation.

Principal
In Windchill applications, an individual user or user group.

Product
A product is typically thought of as the physical item manufactured and sold 
to customers. Pro/INTRALINK 8.0 expands the concept of a product to 
include the environment in which users collaborate to develop that end item. 
This environment is known as the product context.

Site
The site is the company. The site administrator is the administrator that gets 
the system up and running for the customer. The Site tab provides access to 
all administrative areas, rules, and data of the site.

Workflow
Enables you to automate procedures in which information, tasks, and 
documents are passed among several participants.
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